Oracle® Fusion Middleware
Using the Ariba Adapter

Release 14c (14.1.2)

F81842-02

August 2024

Contents 1-1



Oracle Fusion Middleware Using the Ariba Adapter, Release 14c (14.1.2)
F81842-02

Copyright © 2020, 2024 Oracle and/or its affiliates. All rights reserved.
Primary Author: Sunil Kumar

Contributors: Ranga Reddy Mekala, Shubham Baburao Shirure, Arpit Gupta, Ramya S, Ashok Kumar Reddy Nekkanti, and
K Rajendra Prasad

This software and related documentation are provided under a license agreement containing restrictions on use and
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or
allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit,
perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of
this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any
errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S.
Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to
U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure,
modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government
contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood
City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not developed or
intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury.
If you use this software in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup,
redundancy, and other measures to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any
liability for any damages caused by use of this software in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their
respective owners.

This software and documentation may provide access to or information on content, products, and services from third parties.
Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to
third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or
damages incurred due to your access to or use of third-party content, products, or services.

Contents 1-2



Contents

GO NS e, 1-3
] - ol YU 1-5
1. Introduction to the Ariba Adapter.....ouiii i e 1-6

Differences Between Using this Component in the Cloud and On-Premises Environments1-6

ADOUL the AriDa AAPLer ... i e e e ae e e e raba e e e e nereee s 1-6
F N | W No Y o) (=T g VI I O T SR 1-7
P OUISTTEES ..ttt annan 1-7
About Ariba Integration Methods...........oiiiciiieiiiiiie e 1-8
Currently Supported Integration Methods........cccccuveiiiiiii i 1-8
Enabling the Integration Task in Ariba.........cccueieeiiiie i 1-8
Generating a WSDL File to Call Ariba with the SOAP Adapter.......cccceeeeciieeiccieeeeeciieeeeas 1-10
INStalling the CloUd AdaPLers......cuiii et e e e e e e e e e rrae e e e 1-11
Performing Postinstallation Configuration Tasks.........cccceeveiieiiiiiien e, 1-11
Obtaining the Authentication Credentials........ccccoecieeiiiciiii e 1-11
UNSUPPOIEA FEALUIES ..ottt eetree e e e e e et e e e s e e e s ba e e e e e e e e e esnranneeeeeeeean 1-12
2. Creating an Ariba Adapter CONNECLION........ccocciiiieiciiie e e 2-13
Designing an Integration with the Adapter Configuration Wizard..........cccccovvveeeevieeennnee. 2-13
Monitoring Your Application During RUNEIME ........eeeiiiiiiiiiiiee e 2-16
ArTITacts Creation ....coiueeieiiieee et st 2-16
3. Designing SOA Composite APPlICatioNS......c.uvieieiiieieccieee e e 3-17
Creating a SOA Composite APPliCatioN .......coocciiiii i 3-17
Adding an Adapter to a SOA Composite Application as a Reference ......ccccccvvevevnrvenennen. 3-18
Completing Design of a SOA Composite Application.........ccceecvveeiviiiie i 3-18
4. Designing Oracle Service Bus BUSINESS SEIVICES .......cccccuieieiiiieeeiiiieeeccieeeeeeeee e erveee e 4-20
Creating an Oracle Service Bus BUSINESS SEIVICE ......uuviiieieeieeciiiiieeee e eeecirree e e e e nveaeeeas 4-20
Adding an Adapter to a Business Service as a Reference .......ccccccoveeeecieeeeecieeececieee e, 4-20
Completing Design of an Oracle Service Bus BUSiNess ServiCe.......coocvvvcvreeircieeeesciieeeenans 4-21
5. Configuring Ariba Adapter Properti€s .....ccccueeieiiieiiiiieee et eeee e 5-23

Contents 1-3



Configuring Basic INformation Properties.......c.cceeeecieeeiecieei e eree e 5-23

What You Can Do from the Basic INfo Page.......cccuvevveiiiiiicieee e 5-23
What You See on the Basic INfO PAge ....ccccveeiiiiiiieiciiee ettt 5-24
Configuring Oracle Cloud Adapter Connection and CSF Key Properties.......ccccccceeeurrnnenn. 5-24
What You Can Do from the Oracle Cloud Adapter Connection Page .........cccceeeevveeennes 5-24
What You See on the Oracle Cloud Adapter Connection Page........ccccceeeecveeeeecieeeennns 5-25
What You Can Do from the Oracle Cloud Adapter CSF Key Page .......cccoeecvveeevvveeeennnen. 5-25
What You See on the Oracle Cloud Adapter CSF Key Page.......cccccvvvieiivvceeniiciien e, 5-25
Configuring Ariba Adapter Invoke Operation Properties .........ccovcceeeeeeeecciiveeeeeeeeeecvvneen, 5-26
What You Can Do from the Ariba Adapter Invoke Operations Page...........cccceeeevveeennns 5-26
What You See on the Ariba Adapter Invoke Operations Page.........ccccoceeeeecvieeeccrveeeennns 5-26
Reviewing Configuration Values on the SUMMary Page.......cccccoveveeeivcciienecciiee e 5-27
What You Can Do from the SUMMary Page......cccceveieieiiciiee ettt 5-27
What You See on the SUMMAry PAE .....cccuveviiiiiiii ettt ee e e 5-28

6. Managing APPlICAtIONS ...cccuviiieeiiee e e et e e e ares 6-29
Managing the Application in Oracle Enterprise Manager Fusion Middleware Control.....6-29
Testing Oracle Service Bus Business Services from Oracle Service Bus Console................ 6-29

/2 o TV o] F=1] Vo o 4oV S0 TP 7-31

Contents 1-4



Preface

Using the Ariba Adapter describes how to use the Ariba Adapter in your SOA composite
applications and Oracle Service Bus business services.
This section consists of the following topics:

e Audience

e Related Resources

¢ Conventions

Audience

Using the Ariba Adapter is intended for users who want to create, deploy, test, and monitor
applications that use the Ariba Adapter.

Related Resources
For more information, see these Oracle Resources:
e Developing SOA Applications with Oracle SOA Suite
o Administering Oracle SOA Suite and Oracle Business Process Management Suite
e Administering Oracle Service Bus

e Understanding Technology Adapters

Conventions

The following text conventions are used in this document:

Convention Meaning

Boldface type indicates graphical user interface elements

boldface associated with an action, or terms defined in text or the glossary.
italic Italic type indicates book titles, emphasis, or placeholder variables
for which you supply particular values.
Monospace type indicates commands within a paragraph, URLS,
monospace

code in examples, text that appears on the screen, or text that you
enter.
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1.
Introduction to the Ariba Adapter

This chapter consists of the following sections:
o Differences Between Using this Component in the Cloud and On-Premises Environments
e About the Ariba Adapter
e Ariba Adapter Use Case

e  Prerequisites
e About Ariba Integration Methods

e  Currently Supported Integrations Methods

e Enabling Integrations Task in Ariba

e Generating a WSDL File to call Ariba with SOAP adapter

e Installing the Cloud Adapters

e Performing Postinstallation Configuration Tasks

e Obtaining the Authentication Credentials

e Unsupported Features

Differences Between Using this Component in the Cloud and On-
Premises Environments

There may be differences between using this component in the cloud and on-premises environments
that impact the information described in this guide.

For information about differences, see Differences Between the Cloud and On Premises
Environments and Known Issues for Oracle SOA Cloud Service.

About the Ariba Adapter

Ariba is a SaaS-based application that integrates and automates B2B Procurement processes with
Ariba solutions. The Ariba Adapter enables you to do B2B transactions between buyers and
suppliers and it also allows you to import and export master and transactional data integration
between ERP Systems and Ariba Procurement Solution P2P or P20.

Avriba is a Cloud based B2B marketplace where buyer and supplier can find each other and can do
business with each other on a single platform. Ariba comes mainly as a Buyer and Supplier Network
Module where each one of them can do business. A buyer can search about the supplier, procure
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goods and services and track spend. Suppliers can manage their catalogs, purchases, bids and
invoices.

Avriba is the best solution for today’s increasing businesses and for manufacturing companies to have
a close collaboration with their partners, resource vendors and customers. This requires sharing
information, real-time status reports and documents as well as collaborating on critical business
processes like procurement, e-Commerce, e-invoicing, and other operations. SAP Ariba is the
marketplace for modern business, creating simple, intelligent exchanges between millions of buyers
and sellers.

The Ariba Adapter enables you to create an integration with an Ariba Buyer SaaS application. This
cloud adapter framework securely connects and integrates data only with the Ariba Buyer system.

The Ariba Adapter for Oracle SOA Middleware is used for implementation of round-trip
communication between ERP systems and Ariba.

The Ariba Adapter allows integration of Ariba Procurement solution with ERP system and allows
administrators to import master data and export transactional data from any ERP systems to a
procurement system seamlessly.

Ariba Adapter Use Case

This use case describes how a Manufacturing company used the Ariba Adapter to simplify supply
chain management, reduce order complexity, and improve the efficiency of supply operations.

e A customer makes an online purchase of a Material produced by the Manufacturing company.
e The Ariba Adapter sends the purchase request to the Manufacturing company.
e The Manufacturing company locates the requested Material and prepares it for shipment.

e The Manufacturing company uses the Ariba Adapter to inform the customer that the purchase has
been shipped and provides tracking information.

e The Ariba Adapter updates the inventory information for the product ordered by the customer.

e The real-time integration patterns supported by the adapter can be either Web service based or
ITK based.

e The adapter can handle all types of sourcing and Procurement flows that are used in
manufacturing companies, to import and export the master and transactional data between Ariba
and ERP systems.

Prerequisites
To use the Ariba Adapter:

e You must have Ariba user account and credentials for creating CSF key in SOA.

e Based on this security key, you can call the Ariba Application from SOA.

Note: The system administrator should provide the permission and credentials for creating CSF
key in SOA.

Application Support

e The Ariba Adapter is compatible with Ariba Spend Management version:15.
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e The adapter is compatible with all versions of cloud releases of different modules starting from
Apr 2015. The supported modules are:

e Procure to Pay

e Ariba Souring

About Ariba Integration Methods
The Ariba Application supports three types of methods to integrate data.
o File-based integration (ITK)
e Web Service based integration
e  Ariba Network

File-based integration (ITK)

Ariba ITK (Integration Tool Kit) allows buyers to integrate Ariba with any ERP system to exchange
master and transactional data via CSV file upload and download.

Web Service based integration

It is a direct connectivity to Ariba, based on WSDL we will develop the APIS and we can directly
connect Ariba Application to upload and download master and transactional data, Ariba SOAP web
services use the W3C SOAP messaging framework to exchange messages over HTTP or HTTPS.

The Ariba Integration Manager generates descriptions of the Ariba SOAP web services operations in
the Web Services Description Language (WSDL), an XML-based language. Typically, developers
on the EALI system use the WSDL descriptions when creating Integrations to communicate with
Ariba SOAP web services.

Currently Supported Integration Methods

Currently the Adapter supports only outbound Web services data integration with the Ariba
Application and ERP System. Currently, Ariba Network is not supported.

Enabling the Integration Task in Ariba

You need to enable the Integration task in Ariba before performing any operation in SOA.

Note: If the operation (Event) is not enabled in the Ariba application, the data will not be sent to
the Ariba application for that event (Operation).

1. On the Ariba Spend Management dashboard, click Manage and then Administration.
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HOME CONTRACTS
Catalog » | Keywords

Common Actions
Create

Requisition
Knowledge Project
Invoice

Contractor Survey
Mare

Manage
Administration

WMy Tasks

Core Administration

More

2. From the left menu,

PROCUREMENT CATALOG MORE._~ Recent Manage

v Q 3\

v 1 Vote Now! Make your voice heard: cast your votes for future enhancements.

News v

Announcing a new FISher Scientific catalog** Please see the link on the Catalog Page.

Procurement Home Page

For all further information on EasyBuy and training related documents, please click the link https://shareane sri com/corp/shs/procurement/EasyBuy/_layouts
/15/start aspxt/

To Do v My Requisitions v My Receipts o

0 Denied 0 Denied
|

click Integration Manager and then click Integration Configuration.

HOME PROCUREMENT CATALOG ADMINISTRATION MORE _» Recent Manage

¥ Site Manager
Data Import/Export
Audit Log

¥ Integration Manager
Data Import/Export
Data Definition
Integration Configuration
End Point Configuration
Integration Toolkit Security
Master Data Default Values

» Customization Manager
» User Manager
» Dashboard Manager

» Supplier Manager

Integration Configuration

Search, edit, activate or deactivate data import/export tasks. Search fields are case-insensitive and you can enter all or part of a name.

Search Filters:

Task Name:
Format: (novalue) ~v

End Point: (no value) v

Status: | o/ | Enabled Disabled

Configuration

il
«

Tasks 1 Format  Enabled Supported Formats

3. Find the task you want to enable. Select List All or enter search criteria and click Search.
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4. For the task, click Action and then click Edit. An Edit data import/export task pane appears as
shown in the figure.

¥ Integration Manager
Data Import/Export Task Name
Data Definition
Integration Configuration IFEmE \Web Serice
End Point Configuration

End Point InboundEndpaint  ~
Integration Toolkit Security

Supplier Integration Configuration Status: +/ Enabled +/ Disabled List All

» Master Data Manager

» Supplier and Customer Manager Configuration =
» User Manager Tasks 1 Format Enabled Supported Formats

[Deprecated] Upload document
» Customization Manager ris has been

Web
ecated. Use Impart Document, Impart Form Document or Impart Sourcing Event Segmce No [Web Senvice] Actions v
Web .
v No [Web Senvice] Actions v

» Reporting Manager

Edit
» Project Manager
Enable
» Dashboard Manager Disable
» Commodity Code Manager
5. Inthe Status field, select Enabled.
HOME PROCUREMENT CATALOG ADMINISTRATION MORE...» Recent Manage

Edit data import/export task

Activate or deactivate task, specify integration format and connectivity information
Name: Catalog ltem Search  View WSDL
Description:  Search for Catalog ltems
status: @ Enabled Disabled

Format Web Service ~

Feedback

Type: Inbound to Ariba System

End point:  InboundEndpoint_Test ~ @

URL-*

6. Use the drop-down menu for the End point field to select an end point.

7. If you are configuring a service that uses an outbound end point, specify the URL for the
corresponding endpoint on the EAI system.

8. Click Save.

Generating a WSDL File to Call Ariba with the SOAP Adapter
Follow the steps mentioned below for generating WSDL in Ariba:

1. On the Ariba Spend Management dashboard, click Manage and then click Administration.
2. Click the expansion arrow for Integration Manager.
3. Select Integration Configuration.
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4. Find the task for which you want to generate the WSDL file. Select List All or enter the search criteria
and click search.

5. Click Actions and then Edit for the task.
6. Click the View WSDL link.

HOME PROCUREMENT CATALOG ADMINISTRATION MORE..» Recent Manage

Edit data import/export task

Activate or deactivate task, specify integration format and connectivity information.
Name: Catalog ltem Search  View WSDL
Description:  Search for Catalog ltems
Status @ Enabled Disabled
Format: Web Service
Type:  Inbound to Ariba System
End point: | InboundEndpoint Test ~ | @

URL-*

Cance‘

e When you click the View WSDL link shown in the above picture, the WSDL opens in the
browser and you can save it in your local system and then expose that as a SOAP service in SOA.

Installing the Cloud Adapters

See the README.txt available with the patch for instructions on installing the cloud adapters. After

you complete the adapter installation, perform the tasks described in Performing Postinstallation
Configuration Tasks.

Note: For information about supported versions and platforms, see the release certification matrix at
Supported System Configurations.

Performing Postinstallation Configuration Tasks
You must perform postinstallation configuration tasks after installing the cloud adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud Adapters
Postinstallation Configuration Guide.

Obtaining the Authentication Credentials

To access Ariba you must have an existing Ariba user account. A user account is required to provide
the credentials necessary to create the connection and integration.

The Admin user can provide Security Credentials to the user by creating new permissions for
inbound and outbound Endpoint Configuration.

The same credentials can be used by the end user while creating the connection and integration in
SOA & OSB.

Introduction to the Ariba Adapter 1-11
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Unsupported Features
The adapter does not support the following features:

e Currently, the Ariba (SOA) adapter does not provide support to integrate with Ariba Network.

o Adapter runtime retry configuration properties such as jca.retry.count, jca.retry.backoff,
jca.retry.interval, and jca.retry.maxInterval.

e Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion Middleware Control.

o The display of properties in the Properties tab for a reference (outbound) adapter in Oracle
Enterprise Manager Fusion Middleware Control (for example, service WSDL URL, CSF key
used, and others). These are the reference adapters that you select on the Services and References

page.
e Rejected message handling

o The following message encryption and decryption features available when you right-click a cloud
adapter in the Exposed Service swimlane or External References swimlane in Oracle
JDeveloper:

o Protect Sensitive Data > Encrypt Request Data for cloud adapters in the Exposed
Service swimlane.

o Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the External
References swimlane.

e The policy attachments feature available when you right-click a cloud adapter in the Exposed
Service swimlane or External References swimlane in Oracle JDeveloper.
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2.

Creating an Ariba Adapter

Connection

This chapter consists of the following topics:

e Designing an Integration with the Adapter Configuration Wizard

e  Monitoring Your Application During Runtime

e Artifacts Creation

Designing an Integration with the Adapter Configuration Wizard

You use the Adapter Configuration Wizard to include the Ariba Adapter in a SOA composite
application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to select the
artifacts required to communicate with the Ariba Cloud application. You can configure the adapter in
the outbound (target) direction.

1. The Basic Info page prompts you to enter a meaningful name and optional description.
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) Configure a Ariba Cloud Connection - Step 1 of 4

Welcome to the Cloud Connection Configuration Wizard

Basic Info This wizard helps you create a service using the Ariba Cloud Connection.
‘fou will be asked to specify configuration parameters and define an operation for the service.

*What do you want to call your endpaint?

.\%.
+ Connection
I

AribaReference

What does this endpaint do?

Help Mext = Cancel

2. The Connection page prompts you to specify the Ariba Host Name, Application Name, Partition
Name and Security Policy and Authentication Key to use. The authentication key is created by
clicking the Add icon to specify the key name, user name, and password. You must also specify these
same values in Oracle Enterprise Manager Fusion Middleware Control. For instructions, see the
Oracle Cloud Adapters Postinstallation Configuration Guide.

'o Configure a Ariba Cloud Connection - Step 2 of 4

Ariba Cloud Server Connection

¢ Basic Info Ariba server credentials required to access Ariba and resources
T
@ ‘Connection
| .
T Operafions @ Where can I find the Objects you need?
i *Host Name: | xxxxxxxxxxxxxxxxxxx |
*Application Mame: | ========= |
*Partition (Site Name): | =========== |
@ Pick the key to get in the door
Security Policy: CUSTOM ~
*Authentication Key: 3¢ 7R
admin ¥
Test
Refresh MetaData Cache:
e < Back Next = Cancel
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3. The Operations page prompts you to select the target operation that you are going to perform in the
Ariba Application.

O Configure a Ariba Cloud Connection - Step 3 of 4
Configure the operation to perform in the target Ariba application.
] Select the target operation to perform in the Ariba application.
T Connection
w Operations Ariba Solution:
T
|
S s -
& summary Operations: Q, Filter by operation name
Remove Organizations
Create External Request For Approval
Create Event
Add Users To Group
Import Contract Workspace
Create Sourcing Project
Import Sales Contract Request
Import Document
Frocess Requisition Externally
Import Contract Line Items Document
Import Sales Contract Workspace
Description:
Help < Back MNext > Cancel

4. The Summary page displays your selections for the outbound direction.
‘ﬂ Configure a Ariba Cloud Connection - Step 4 of 4

Summary

Basic Info Here's a summary of all the choices you've made and some Next steps.
Connection

Operations Selected Module:  Buyer

e —c—¢

| Summary Selected Operation:

Help < Back Finish Cancel

5. The Adapter will be visible in the External references of JDeveloper.
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Exposed Services Components External References

o3

E AribaReference

i Operations:

E RemittancePullMotify

Design| Source History Annotations

Monitoring Your Application During Runtime

This section describes the design time and runtime aspects of using the Ariba Adapter. You use the
runtime part of the adapter for delivering the information generated during design time to the service
endpoint. You can monitor your SOA composite application or Oracle Service Bus business service
from Oracle Enterprise Manager Fusion Middleware Control. You can also test your Oracle Service
Bus business service from Oracle Service Bus Console.

Artifacts Creation

The following artifacts are created for each adapter instance in the Applications window in Oracle
JDeveloper:

o WSDL file: Only the standard WSDL file type is supported.

e JCA file: Contains the internal implementation details used by the adapter during runtime. It
contains the different interaction and connection properties used by the adapter.

When application configuration is complete, you can deploy the application from Oracle JDeveloper
to the runtime environment.

For information about the details to specify in the fields of the wizard pages, see Configuring Oracle
Ariba Cloud Connection Properties.
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3.

Designing SOA Composite
Applications

This section describes how to design a SOA composite application with the Ariba Adapter.
This section consists of the following topics:

e Creating a SOA Composite Application

e Adding an Adapter to a SOA Composite Application as a Reference

e Completing Design of a SOA Composite Application

Creating a SOA Composite Application

This section provides an overview of how to create a SOA composite application in which to include
the adapter as an exposed service or external reference.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.

3. Inthe New Gallery dialog, select SOA Application from the Items list, then click OK. The SOA
Create SOA Application wizard is displayed.

4. Specify an application name, and click Next.
5. Specify a project name, and click Next.
6. Select Composite with BPEL Process, and click Finish.
The SOA composite application is displayed for designing in the SOA Composite Editor.
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Adding an Adapter to a SOA Composite Application as a Reference

You can add an Ariba Cloud Cloud adapter to a SOA composite application as an outbound (target)
reference to the External References swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your SOA composite application.
2. Go to the Cloud section under Custom/Third Party.
The adapters are displayed.

3SmrtPage D{E Projectl .. Components Resources
&P d Rl UG B a8 Project1 | O~ ©
Components External References SOA -
i
da @ & < LF &
BPEL Process  BusinessRule  Human Task Mediator Spring Subprocess
Technology
= & & k™ ® @ & @
~ ADF-BC AQ B2B BAM Coherence Database Direct EB
To create resources, drag and drop an icon
i 8z ny
from the component palette to the canvas {% {0 qﬁ B ‘%’ @ @ L
File FTP Healthcare HTTP Ms LDAP MFT MQ
select one from the right-click context menu
o 2
i L & i &
MSMQ REST SOAP Socket ums
Applications
& e &
E-Business IDE World SAP
Suite
CustomyThird Party
@
Jesign| Source History Annotations Third Party
=an)
Messages - Log Cloud
juild after save building project 2 of 2 queued projec ‘4 ﬁ Q h C’H) C/\) % F =
- & = =
. 1 ARIBA - s o for Salesforce ServiceMow
:cmpl ngeo- . , e Eloqua NetSuite Oracle ERP Oracle Oracle Sales
lompilation of project 'Projectl.jpr' finished. Check Adapter Adapter Cloud Righthaw Cloud
12:58:13 PM] Successful compilation: 0 errors, 0 warni

=

3uild after save finished Surcesafar...

3. To create an outbound (target) reference, drag the adapter to the External References swimlane, and
see the following sections that describe the wizard pages for configuring the adapter

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties
e Configuring Ariba Adapter Invoke Operations Page
e Reviewing Configuration Values on the Summary Page

Completing Design of a SOA Composite Application

This section provides an overview of how to complete design of your SOA composite application
and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a) Connect the BPEL process to the adapter. For this example, the BPEL process is connected to
the adapter as an external reference:

b) Design the contents of the BPEL process. For example:

a. Double-click the BPEL process.

b. Add and configure an invoke activity to invoke the adapter

Designing SOA Composite Applications 3-18



c. Add and configure assign activities to copy the contents of one variable to another
when sending and receiving messages to and from the adapter.

d. Add and configure other activities, as appropriate.
When complete, view the SOA composite application in the SOA Composite Editor.

For specific information about creating and designing SOA composite applications, see Developing
SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:
a. Inthe navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite application to the
application server.
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4.

Designing Oracle Service Bus

Business Services

This section describes how to design an Oracle Service Bus business service with the adapter in
Oracle JDeveloper.

e Creating an Oracle Service Bus Business Service

e Adding an Adapter to a Business Service as a Reference

e Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business service in which
to include the adapter in Oracle JDeveloper.

Start Oracle JDeveloper.

From the File menu, select New > Application.

In the New Gallery dialog, select Service Bus Application from the Items list, then click OK.
Specify an application name, and click Next.

Specify a project name.

@ o~ w b

Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle Service Bus
Overview Editor.

Adding an Adapter to a Business Service as a Reference

You can add the adapter to an Oracle Service Bus business service as an outbound (target) external
service to the External Services swimlane in Oracle JDeveloper.

Note: If the Import OSB Resource dialog is displayed during adapter configuration, click Cancel.
You cannot localize the WSDL file.

1. Go to the Component Palette in your Oracle Service Bus business service.
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2. Go to the Cloud section under Custom/Third Party.

Custom Third Parky

s
Third Party
Cloud
o
ARIBA . =
Elogua MetSuite Oracle ERF Oracle
Adapter Adapter Cloud RightMaow
= = =
Salesforce ServiceMow Successfac, ..

3. To create an outbound (target) external service, drag the adapter to the External Services swimlane,
and see the following sections that describe the wizard pages for configuring the adapter:

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Configuring Ariba Adapter Invoke Operation Properties

e Reviewing Configuration Values on the Summary Page

Completing Design of an Oracle Service Bus Business Service

This section provides an overview of how to complete design of your Oracle Service Bus business
service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to configure an Oracle
Service Bus proxy service in your business service:

a) Inthe Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins lane and
select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.
b) Enter a name for the pipeline and select the project location, then click Next
c) Select WSDL as the Service Type.
d) To the right of the WSDL selection, click the Browse icon to select the WSDL.
e) Select Application.
f) Expand Resource Chooser and select the WSDL file, then click OK.
g) Ensure that Expose as a Proxy Service is selected.

h) From the Proxy Transport list, select http, then click Finish.
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The Pipeline component is displayed in the Oracle Service Bus Overview Editor.
i) Connect the external service to the Pipeline component.

For more information about creating and designing an Oracle Service Bus business service, see
Developing Services with Oracle Service Bus.
2. Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the Routing Properties tab at the
bottom of the dialog.

The outbound project is ready for deployment.
4. Deploy the business service.

Note: You cannot use Oracle JDeveloper to deploy a business service to Oracle SOA Cloud Service.
For information about other deployment options, see Using Oracle SOA Cloud Service.

a) Select the project, then select Deploy to Service Bus Server.

b) Follow the steps in the deployment wizard.
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5.
Configuring Ariba Adapter

Properties

The Ariba Adapter enables you to create integrations with a Ariba Saas cloud application.

The following sections describe the wizard pages that guide you through configuration of the Ariba
Adapter as an invoke in an integration. The Ariba Adapter cannot be configured as a trigger in an
integration.

This chapter consists of the following topics:

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Configuring Ariba Adapter Invoke Operation Properties

e Reviewing Configuration Values on the Summary Page

Configuring Basic Information Properties

You can enter a name and description on the Basic Info page of each source and target adapter in
your integration.

This section consists of the following topics:

¢ What You Can Do from the Basic Info Page

¢ What You See on the Basic Info Page

What You Can Do from the Basic Info Page

You can specify the following values on the Basic Info page. The Basic Info page is the initial
wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke (target)
area supported by your adapter.

e  Specify a meaningful name.

e Specify a description of the responsibilities.
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What You See on the Basic Info Page

The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can
understand the responsibilities of this
connection. You can include English
alphabetic characters, numbers, underscores,
and dashes in the name. You cannot include
the following:

e Blank spaces (for example, My
Inbound Connection)

e Special characters (for example,
#;83& Orrigh (t)now4)

e Multibyte characters

What does this endpoint do? Enter an optional description of the
connection’s responsibilities. For example:
This connection receives an
inbound request to synchronize
account information with the
cloud application.

Configuring Oracle Cloud Adapter Connection and CSF Key
Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework (CSF)
key values for your integration.

This section consists of the following topics:

e What You Can Do from the Oracle Cloud Adapter Connection Page

¢ What You See on the Oracle Cloud Adapter Connection Page
e What You Can Do from the Oracle Cloud Adapter CSF Key Page
e What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page

You can specify the following connection values for the Oracle Cloud adapter.

o  Specify the WSDL URL for some adapters. For the Ariba Adapter ,you need to specify the
HostName, Application Name, and Partition Name.

e Specify the security policy.

o Create the authentication key. A key created for one direction (for example, outbound) is also
available for selection in the other direction (for example, inbound).
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What You See on the Oracle Cloud Adapter Connection Page

The following table describes the key information on the Oracle Cloud Adapter Connection page.

Element Description
Enter the host name of the SAP Ariba server..

Host Name
For example: https:/ /sl.ariba.com

Select Buyer.

Application Name

Note: Supplier is not supported.

In the Partition (Site Name) field, enter the name
of the SAP Ariba server partition on which you
want to execute operations.

For example: ***** /Procurement.sl.ariba.com
Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

* The wizard shows all policies, including
those that may not be applicable. To make

a correct selection, you must have a

knowledge of policies. For example, you

cannot select a SAML-based policy

because the identity is not propagated.

* The policies you apply to the cloud

adapter are unique to the cloud adapter

and do not impact other endpoints in the
composite.

Select the CSF authentication key.

¢ Add: Click Add to create a new authentication
key. You must specify the key name, user name,
and password.

¢ Edit: Click to edit an authentication key.

* Delete: Click to delete an authentication key.
Click to validate the authentication key.

Partition Name

Security Policy

Authentication Key

Test

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

e CSF key name
e User name and password

e Re-enter password

What You See on the Oracle Cloud Adapter CSF Key Page
The following table describes the key information on the Oracle Cloud adapter CSF Key page.

Element Description

Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password

CSF Key Name
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required for authentication with the
application (for example, the Oracle Sales
Cloud or Oracle ERP application). This key
identifies your login credentials during
design-time.

Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle ERP application). Your
administrator provides you with user
credentials.

User Name

Enter the password for connecting to your

Password N
application.

Re-enter the same password a second time.

Re-enter Password

Configuring Ariba Adapter Invoke Operation Properties
Enter the Ariba Adapter invoke operation values for your integration.
This section consists of the following topics:

e What You Can Do from the Ariba Adapter Invoke Operations Page

¢ What You See on the Ariba Adapter Invoke Operations Page

What You Can Do from the Ariba Adapter Invoke Operations Page

You can configure the following invoke operation values for the Ariba Adapter.

e  Select the operation to perform.

e Select the business object on which to perform the operation.

What You See on the Ariba Adapter Invoke Operations Page

The following table describes the key information on the invoke Operations page.

Element Description

Click Next Steps This feature is not currently available.

Select Operation Type ¢ Import Contract Workspace — Imports
contract workspace information from an
external application into the SAP Ariba
application

* Create Suppliers — Imports supplier
information from an external application into
SAP Ariba.

* Create Event — Imports event information
from an external application into SAP Ariba.

* Create External Request For Approval —
Imports external requests for approval from an
external application into SAP Ariba.
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 Create Remittance — Returns the amount
paid to suppliers for each invoice. Select this
operation when remittance information is
imported from an ERP application directly into
SAP Ariba.

¢ Create Sourcing Project — Creates a
sourcing project.

* Create Organizations — Creates an
organization.

¢ Create External Contract Information —
Returns contract information from external
applications.

¢ Create Procurement Unit — Imports
procurement unit information from an external
application into SAP Ariba.

¢ Create Requisitions — Imports requisition
information from an external application into
SAP Ariba.

¢ Catalog Item Search — Searches for catalog
items in SAP Ariba to allow the
synchronization of operations between SAP
Avriba and external applications.

Filter by object name Type the initial letters to filter the display of
business objects.

Reviewing Configuration Values on the Summary Page
You can review the specified adapter configuration values on the Summary page.
This section consists of the following topics:

e What You Can Do from the Summary Page

¢ What You See on the Summary Page

What You Can Do from the Summary Page

You can review source or target configuration details from the Summary page. The Summary page is
the final wizard page for each adapter after you have completed your configuration.

o View the configuration details you defined for the source or target adapter. For example, if you
have defined an inbound source adapter with a request business object and immediate response
business object, specific details about this configuration are displayed on the Summary page.

e Click Done if you want to save your configuration details.

o Click a specific tab in the left panel or click Back to access a specific page to update your
configuration definitions.

e Click Cancel to cancel your configuration details.
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What You See on the Summary Page

The following table describes the key information on the Summary page.

Element Description

Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard.

For adapters for which a generated XSD file is
provided, click the XSD link to view a readonly
version of the file.

To return to a previous page to update any
values, click the appropriate tab in the left
panel or click Back.

Summary
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6.
Managing Applications

You can manage and monitor an Oracle SOA Suite or Oracle Service Bus application that uses the
adapter from Oracle Enterprise Manager Fusion Middleware Control or Oracle Service Bus Console.

This chapter consists of the following sections:

¢ Managing the Application in Oracle Enterprise Manager Fusion Middleware Control

e Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service that includes your
adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Log in to Oracle Enterprise Manager Fusion Middleware Control.

2. Inthe navigator, expand the tree to display your SOA composite application or Oracle Service Bus
business service project (for this example, a SOA composite application is selected).

3. Select the SOA composite application.
4. Click Test.
The Test Web Service page is displayed.
5. Complete the fields on the page to initiate a test of your composite.
6. Click Test Web Service.
Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application, including flow
details about the adapter.

For more information about monitoring applications from Oracle Enterprise Manager Fusion
Middleware Control, see Administering Oracle SOA Suite and Oracle Business Process Management
Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service
Bus Console

You can test Oracle Service Bus business service projects from Oracle Service Bus Console.

1. Log in to Oracle Service Bus Console.
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2. Inthe navigator under All Projects, open the project to test.
In the navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.
This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed under the Response
Document section.

For more information about testing Oracle Service Bus business service projects, see Administering
Oracle Service Bus.
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Troubleshooting

The following table describes the troubleshooting information.

Error Cause Solution
javax.net.ssl.SSLHandshakeExcepti | When Ariba Server is Update the

on: Server chose TLSv1, but supporting TLSv1 and SOA | Weblogic.security.SSL.minimumProtocol
that protocol version is not enabled | is ending request with TLS | Version=TLSv1”in the

or not supported by the client version greater than TLSv1l | “setStartupEnv.sh” file
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